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Fall Saturated Soil, Shallow Open Water, and Flooded Grassland Shorebird 
Habitat Assessment 

Relationship to Gulf Coast Joint Venture (GCJV) Habitat Conservation: 

Priority Species: Long-billed Curlew (Numenius americanus), Buff-breasted Sandpiper 
(Caladris subruficollis), Stilt Sandpiper (C. himantopus), Western Sandpiper (C. mauri), 
and Short-billed Dowitcher (Limnodromus griseus) 

Planning Objective: To implement land use and conservation practices to ensure sufficient 
inland saturated soil, shallow open water, and flooded grassland habitat (primarily 
flooded agricultural lands and moist-soil impoundments) to meet foraging requirements 
for target numbers of shorebirds during fall. Shorebird habitat objectives were generated 
using an energetics-based model.  Objectives are partitioned into early (15 Jul–9 Sep) and 
late (10 Sep–5 Nov) based upon migration chronology of priority species. The model 
assumes depletion of food base over time resulting in the need for cumulative additions 
of habitat. Target habitat objectives for the early period range from approximately 52–
59% of total objective acres depending on the GCJV Initiative Area (IA; fig. 1). The 
differences in IA early period targets are due to individual shorebird species migration 
chronology and distribution. Target habitat objective for late period is the total objective 
acres. 

 
Type of Monitoring: Habitat 
 
Monitoring Metric: Acres of inland saturated soil, shallow open water, and flooded grassland habitat 
 
Monitoring Objective: Estimate the acres of inland saturated soil, shallow open water, and flooded 

grassland habitat during the early and late fall periods in all GCJV IA (with the exception of 
Laguna Madre for which habitat estimation is only conducted for the portion of the IA that 
intersects Bird Conservation Region 37). Habitat deficits relative to objectives provide impetus 
for intensifying the promotion and delivery of habitat conservation actions described in GCJV IA 
plans.    

 
Brief Methodology: Landsat surface reflectance satellite imagery is inventoried for each Landsat scene 

(fig. 1) and time period for each GCJV initiative area. Seamless mosaics are created for each 
initiative area for each period (i.e., IA assessment) with preference given to highest quality cloud-
free images that are chronologically as close together as possible. Ideally, there would be equal 
representation across years for seamless imagery from the early (15 Jul–9 Sep) and late (10 Sep–5 
Nov) fall migration periods. For each IA assessment, we report the range of acquisition dates for 
Landsat scenes classified (e.g., 15 Sep–28 Sep) and estimate a mean weighted acquisition date for 
imagery used (e.g., 21 Sep; fig. 1).  
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Figure 1. Coverage of Landsat TM scenes within the GCJV, Laguna Madre, Texas Mid-Coast, Texas 
Chenier Plain, Louisiana Chenier Plain, Mississippi River Coastal Wetlands, and Coastal 
Mississippi-Alabama Initiative Areas. 

The image mosaic is preprocessed and classified using ArcMap and ERDAS IMAGINE (ERDAS 
Inc., Norcross, GA) software. The GCJV coastal marsh, forested, and permanent water exclusion 
mask is combined with Coastal Change and Analysis Program (C-CAP) data and is applied to the 
image mosaic to restrict the classification to only those areas that may contain agricultural-based, 
moist-soil habitats, flooded grasslands, and temporarily and seasonally flooded palustrine 
emergent wetlands. Standardized threshold-based models are used to classify the masked 
composite image into habitat classes.  The classification scheme consists of Water, Vegetated 
Water, and Saturated Soil. Classifications are reviewed and glaring commission errors (i.e., 
impervious surfaces associated with developed areas being classified as habitat) are manually 
recoded to the correct class. A minimum mapping unit of one acre is applied to habitat areas (i.e., 
any combination of habitats including Water, Vegetated Water, and/or Saturated Soil). Final 
shallow water acreages for both the Water and Vegetated Water classes and percent open (i.e., 
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available) within the Vegetated Water class is estimated by applying parameter estimates derived 
from field validation.   
 
Some assessments may be developed even if cloud-free imagery is not available for the entire IA.  
For each IA, rules were developed to highlight which scenes are mandatory for developing a 
habitat assessment. If an assessment does not have full coverage, then linear extrapolation is used 
to estimate the amount of habitat that may cover the missing area. This is calculated by 
multiplying the quotient of the habitat areal coverage and the total IA area assessed (i.e., the areal 
coverage of the IA that was assessed with imagery) by the unassessed IA area. This step is 
repeated for each habitat class (i.e., Water, Vegetated Water, and Saturated Soil). See Appendix 1 
(Overview of Waterfowl and Shorebird habitat classifications) for classification Standard 
Operating Procedure. 
 

Monitoring Responsibilities:   
 

Data Collection: GCJV Remote Sensing and GIS Analysts acquire satellite imagery from the 
U.S. Geological Survey Earth Resources Observation and Science Center.   

 
Data Compilation and Analysis: GCJV Remote Sensing and GIS Analysts compile and classify 

satellite imagery. 
 
Report Development: Acreage estimates are compiled in a chronological database by year, 

initiative area, and state within initiative area by the GCJV Monitoring Coordinator.  
Tables and graphs are produced by the GCJV Monitoring Coordinator. 

 
Report Distribution: Data, tables, and graphs are made available upon request to the GCJV 

Monitoring Coordinator. Annually updated tables and graphs may be posted on the GCJV 
website. 

 
Timing and Frequency:  
 

Data Collection: Depending upon availability of cloud-free Landsat TM satellite imagery, data 
are collected and processed annually for two fall shorebird migration periods (i.e., early 
[15 Jul–9 Sep] and late [10 Sep–5 Nov]). 

 
Data Analysis: Classification of satellite imagery for the fall shorebird migration period of the 

current year is initiated at the beginning of the following year.   
 

Report Development: Data, tables, and graphs depicting estimated fall saturated soil, shallow 
open water, and flooded grassland shorebird habitat relative to GCJV objectives are 
updated annually upon the completion of the data analysis. 

 
Detailed Methodology:  
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Data Sources, Seamless Mosaic, and Data Extrapolation: Landsat surface reflectance 
satellite imagery is inventoried for each Landsat scene (fig. 1), time period (i.e., early [15 
Jul–9 Sep] and late [10 Sep–5 Nov]), and relevant initiative area. Seamless mosaics are 
created for each initiative area for each period with preference given to highest quality 
cloud-free images that are chronologically as close together as possible. It is recognized 
that the probability of obtaining two full sets of cloud-free, seamless imagery per year for 
the entire GCJV region is very low. The Texas Mid-Coast IA (TMCIA), Texas Chenier 
Plain IA (TXCPIA), and Louisiana Chenier Plain IA (LCPIA) are a priority because they 
have the largest acreage of saturated soil, shallow open water, and flooded grassland 
habitat objectives allocated to them. For classifications prior to 2011, Landsat 5 will be 
used. From 2013 onwards, Landsat 8 will be used. SPOT 4/5 may be used to fill the gap 
between Landsat 5 and Landsat 8. Imagery is selected to develop seamless image mosaics 
for GCJV IAs for each time period. Preference is given to cloud-free images nearest the 
mid-point of each time period (Early: ~8 Aug; Late: ~8 Oct). Occasionally, cloud-free 
imagery may only be available for parts of an initiative area. Table 1 identifies the 
minimum scene requirements for image classification based on Landsat footprints for 
seamless mosaics. When a seamless mosaic is missing a scene that is not essential for 
image classification, the estimate of fall shorebird habitat is derived from available 
imagery and extrapolated to areas of the IA for which imagery is unavailable. This is 
calculated by multiplying the quotient of the habitat areal coverage and the total IA area 
assessed (i.e., the areal coverage of the IA that was assessed with imagery) by the 
unassessed IA area. This step is repeated for each habitat class (i.e., Water, Vegetated 
Water, and Saturated Soil). If any essential scenes in a seamless mosaic are unavailable 
because of cloud cover, fall shorebird habitat is not estimated for that IA and time period.  

 
 
Initiative area    Scenes 
Coastal Alabama-Mississippi  P21R39 
Chenier Plain (Louisiana)  P24R39 & P23R39 
Chenier Plain (Texas)   P25R39 & P24R49 
Laguna Madre    P26R41& P26R42 
Mississippi River Coastal Wetlands P22R39 & P23R39 
Texas Mid-Coast   P25R40 & P26R39 & P26R40 

 
 

Table 1. Scenes required, at a minimum, for seamless mosaics for each GCJV Initiative Area. 
 

For each IA assessment, we report the range of acquisition dates for Landsat scenes 
classified (e.g., 15 Sep–28 Sep) and estimate a mean weighted acquisition date for 
imagery used (e.g., 21 Sep; fig. 1). The mean weighted acquisition date is estimated for 
the IA assessment by:  (1) reclassifying classified pixels per Landsat scene to Julian 
dates; (2) mosaicking reclassified Landsat scenes used per IA assessment into a seamless 
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Julian date raster; and (3) using zonal statistics to determine mean weighted acquisition 
date for classified areas (i.e., unmasked area) within the IA. The classified area per 
assessment per IA is determined by multiplying the count of pixels classified by the cell 
size (i.e., 900 square meters [0.222 acres] for Landsat). See Appendix 1 (Overview of 
Waterfowl and Shorebird habitat classifications) for detailed Standard Operating 
Procedure for creating scene mosaics and performing data extrapolation. 

 
Preprocessing and Classification: The image mosaic is preprocessed and classified 
using ARCMAP (Esri, 2015; Redlands, CA) and ERDAS IMAGINE (ERDAS Inc., 
Norcross, GA) software. For each scene in an IA assessment, preprocessing involves 
creating a composite image of non-thermal bands, reprojecting the composited image if 
necessary, removing any no-data pixels around the edge of the image, and subsequently 
shifting composites to match the exclusion mask and adjacent imagery. Where 
atmospherically corrected imagery is not available, images are first atmospherically 
corrected to top of atmosphere level. Images are then mosaicked together into a new 
raster covering the IA. Mosaicked Landsat scenes are multiplied by the designated scale 
factor (i.e. 0.0001), shifted and snapped to match the appropriate mask, and subset to the 
IA footprint. The following indices are then calculated from the mosaicked and subset 
image: the modified normalized water index (MNDWI; Xu, 2005), the normalized 
difference vegetation index enhanced vegetation index (NDVIEVI; Torbick, 2015), the 
land surface water index (LSWI; Torbick, 2015), and the normalized difference built-up 
index (NDBI; Zha et al., 2003). The classification is then run using thresholds of the 
calculated indices in order to make decisions (fig. 2). The GCJV coastal marsh and 
permanent water exclusion mask, combined with C-CAP classes, is applied to the image 
mosaic to restrict the classification to only those areas that may contain agricultural-
based, moist-soil habitats, flooded grasslands, and temporarily and seasonally flooded 
palustrine emergent wetlands. For more information see: Y:\Monitor\GCJV 
Documents\Coastal Marsh and Permanent Water Mask-Version Final.doc. Note: SPOT 5 
imagery has a 10-meter spatial resolution and is resampled to 20 meters to match the 
spatial resolution of SPOT 4 imagery. We have created a mask with a spatial resolution 
of 20 meters for use with SPOT imagery by resampling the original 30-meter mask. 
Initial classifications of Water, Vegetated Water, Saturated Soil, and Other for satellite 
imagery are created using a standardized ERDAS threshold-based model. Results from 
the unsupervised classifications are reviewed and glaring commission errors (i.e., 
impervious surfaces associated with developed areas, upland forest, cloud and cloud 
shadow, and areas of obvious river misalignment with the mask) are manually recoded to 
the correct class. See Appendix 1 (Overview of Waterfowl and Shorebird habitat 
classifications) for detailed Standard Operating Procedure for conducting preprocessing 
and habitat classifications. 
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Figure 2. Chart depicting how shorebird saturated soil, shallow open water, and flooded grassland 
classification decisions were made based on threshold values of the normalized difference vegetation 
index enhanced vegetation index (NDVIEVI), normalized difference built-up index (NDBI), land surface 
water index (LSWI), and the modified normalized water index (MNDWI). 
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Post Processing: Areas of contiguous habitat of any or all types (i.e., Water, Vegetated 
Water, and/or Saturated Soil) less than an acre are removed. Final shallow water acreages 
for both the Water and Vegetated Water classes and percent open (i.e., available) within 
the Vegetated Water class is estimated by applying parameter estimates derived from 
field validation. See Appendix 1 (Overview of Waterfowl and Shorebird habitat 
classifications) for detailed Standard Operating Procedure for post processing. 

 
Landsat Scene Exclusions: The TXCPIA and TMCIA have small areas that are not covered by 

the Landsat scenes listed in Table 1. The scenes overlapping these areas (i.e., Path 23 
Row 40, Path 25 Row 40, Path 27 Row 40) are excluded from classification because the 
acreage within them available for classification as potential seasonal surface water (i.e., 
not covered by the exclusion mask) is insignificant to the overall landscape estimates for 
those initiative areas. 
 
The portion Path 23 Row 40, located in southeastern LACPIA and in southwestern 
Mississippi River Coastal Wetlands IA (MRCWIA), is not included in assessments for 
either IA (fig. 1). This scene contains only 1,607 classifiable acres within the LACPIA, 
accounting for only 0.0001% of the total classifiable acres in the LACPIA. All areas 
found within Path 23 Row 40 in the MRCWIA are estuarine wetlands that fall under the 
exclusion mask. Path 25 Row 40 contains the southern half of Bolivar Peninsula in the 
southwest portion of the TXCPIA. This scene contains about 9,782 classifiable acres 
within the TXCPIA, which accounts for only 0.002% of the total classifiable acres in the 
TXCPIA. An earlier classification of this area suggests the potential bias resulting from 
exclusion of Path 25 Row 40 from the TXCPIA image mosaic is small. Specifically, 
seasonal surface water for this area was classified using imagery for Path 25 Row 40 that 
was acquired on 9/4/2008. Climatological data suggested the preceding month (August 
2008) was particularly wet with 8 to 12 inches of rainfall (PRISM Climate Group). Thus, 
seasonal surface water estimated from this image would likely be near the high end of 
potential shorebird habitat available in this portion of Path 25 Row 40. Classification of 
this image revealed only 40 acres of seasonal surface water in this portion of Path 25 
Row 40, providing evidence that potential bias resulting from exclusion of this scene is 
low. 
 
Path 27 Row 40 (fig. 1) covers a small portion of the TMCIA. This scene contains 3,398 
classifiable acres within the TMCIA, and accounts for only 0.0004% of the total 
classifiable acres in the TMCIA.   
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Data and Report Archival: 
 

Y:\Monitor 
• Contains a readme.doc file that describes directories and the files within them. 

 
Y:\Monitor\Surface Water\Shorebird 

• Contains compiled data (Excel spreadsheets), tables (Word documents), and graphs 
relating to estimates of acres of flooded agricultural lands and moist-soil habitats during 
fall period by IA. 

 
Monitoring Related Issues to Consider:  

 
None  

 
References: 
Torbick, N, and W. Salas. 2015. Mapping agricultural wetlands in the Sacramento Valley, USA 

with satellite remote sensing. Wetlands ecology and management 23: 79–94. 
 
Xu H. 2005. A Study on Information Extraction of Water Body with the Modified Normalized Difference 

Water Index (MNDWI). Journal of Remote Sensing 5: 595. 
 
Zha Y., J. Gao, and S. Ni. 2003. Use of normalized difference built-up index in automatically mapping 

urban areas from TM imagery. International Journal of Remote Sensing 24: 583–594. 
 
 
a Monitoring objective, brief methodology, and detailed methodology sections were updated in October 
2017 by Allston and Enwright. 
bEdits were made to the detailed methodology sections and stylistic edits to ensure general consistency 
with the waterfowl habitat assessment monitoring summary in July 2019 by Wollerson and Enwright. 
cEdits were made to the brief and detailed methodology sections in July 2020 by Enwright and Byerly. 
Additionally, edits were made to the planning objective section by Vermillion. 
dFigure 1 was updated to split Texas Chenier Plain and Louisiana Chenier Plain into two separate IAs, 
methodology sections were updates, and full standard operating procedure was added as Appendix 1 by 
Enwright, Byerly, and Faulk in December 2020 
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Appendix 1. Waterfowl and shorebird classifications 
Note: Complete statement of procedures. Procedures specific to shorebirds are those in the sections 
entitled “Overview of Shorebird Classifications” and “Preprocess Imagery” Section 10: “Shorebird 
Classifications.” All other procedures outlined in the appendix are shared for both taxa.  

Overview of Waterfowl Classifications 
Initiative Areas and Imagery Used 

 

Figure 1. Coverage of Landsat scenes within the GCJV Laguna Madre Texas Mid-Coast, Texas Chenier 
Plain, and Louisiana Chenier Plain Initiative Areas. 
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The following is a list of Initiative Areas (IAs) and imagery needed to create a mosaic for classification. 
Note, all images are required for classification unless otherwise noted. The coordinate system for each IA 
is also included.   

Initiative Area Imagery Coordinate System 

Laguna Madre (LAG) • P27R42 (Not necessary if P27R41 is 
available 

• P27R41 (Not necessary if P27R42 is 
available 

• P26R42 
• P26R41 

WGS 84 UTM 14N 

Texas Mid-Coast (TMC) • P26R41 (Not Necessary) 
• P26R40 
• P26R39 
• P25R40 
• P25R39 (Not necessary) 

WGS 84 UTM 14N 

 

Texas Chenier Plain 
(TXCHEN) 

• P25R39 
• P24R39 

WGS 84 UTM 15N 

 

Louisiana Chenier Plain 
(LACHEN) 

• P24R39 
• P23R39 

WGS 84 UTM 15N 

 

Table 1. Waterfowl classification IAs, imagery, and coordinate systems. 

Periods 
Waterfowl habitat data is collected and processed 3 times per year for each IA.  

Early Period: August 16 to October 31 (Mid-point is September 23) 

Middle period: November 1 to January 15 (Mid-point is December 8) 

Late period: January 16 to Mar 31 (Mid-point is February 21) 
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Masks 
Waterfowl Mask 

Imagery Year CCAP/NLCD1,2 Census 
2020-2021 2016 2010 
2019-2020 2010 2010 
2018-2019 2010 2010 
2017-2018 2010 2010 
2016-2017 2010 2010 
2015-2016 2010 2010 
2014-2015 2010 2010 
2013-2014 2010 2010 
2012-2013 2010 2010 
2011-2012 2010 2010 
2010-2011 2010 2010 
2009-2010 2010 2010 
2008-2009 2010 2010 
2007-2008 2006 - Post Katrina 2010 
2006-2007 2006 - Post Katrina 2010 
2005-2006 2006 - Post Katrina3 2010 
2004-2005 2006 - Pre Katrina 2000 
2003-2004 2001 2000 
2002-2003 2001 2000 
2001-2002 2001 2000 
2000-2001 2001 2000 
1999-2000 2001 2000 
1998-1999 1996 2000 
1997-1998 1996 2000 
1996-1997 1996 2000 
1995-1996 1996 2000 
1994-1995 1996 1990 
1993-1994 1992 1990 
1992-1993 1992 1990 
1991-1992 1992 1990 
1990-1991 1992 1990 
1989-1990 1992 1990 
1988-1989 1992 1990 
1987-1988 1992 1990 
1986-1987 1992 1990 
1985-1986 1992 1990 

11992 Data is NLCD data, as CCAP was unavailable after 1996 
2Used to mask out upland forests and high and medium intensity urban areas 
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3Hurricane Katrina made land fall in late Aug 2005, towards the end of the Early shorebird habitat 
assessment period.  

For future classifications, if new land cover or census data becomes available, then the mask will be 
updated for the next full assessment period. For example, if new 2020 census urban data becomes 
available in November 2021, then the mask would be updated for the 2022–2023 assessment. 
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Overview of Shorebird Classifications 

Initiative Areas and Imagery Used 

 

Figure 1. Map of IAs used in shorebird classification and associated Landsat images. 

The following is a list of Initiative Areas and imagery needed to create a mosaic for classification. Note, 
all images are required for classification unless otherwise noted. The coordinate system for each IA is 
also included.  

Initiative Area Imagery Coordinate System 

Laguna Madre (LAG) • P26R42 
• P26R41 

WGS 84 UTM 14N 

Texas Mid-Coast (TMC) • P26R41 (Not Necessary) 
• P26R40 
• P26R39 
• P25R40 
• P25R39 (Not necessary) 

WGS 84 UTM 14N 

 



Final 

14 

 

Texas Chenier Plain 
(TXCHEN) 

• P25R39 
• P24R39 

WGS 84 UTM 15N 

 

Louisiana Chenier Plain 
(LACHEN) 

• P24R39 
• P23R39 

WGS 84 UTM 15N 

 

Mississippi River Coastal 
Wetlands (MRCW) 

• P23R39 
• P23R40 (Not necessary) 
• P22R39 
• P22R40 (Not Necessary) 
• P21R40 (Not Necessary) 

WGS 84 UTM 15N 

 

Coastal Mississippi-
Alabama (CMA) 

• P22R39 
• P21R38 (Not necessary) 
• P21R39 (Not necessary) 
• P20R39 (Not necessary) 

WGS 84 UTM 16N 

 

Table 2 Shorebird IAs, imagery, and coordinate systems 

  

Periods 
Shorebird spring habitat data is collected and processed once per year for each IA.  

Period: March 15 to June 5 (Mid-point is April 26) 

Masks (Updated as needed) 
Shorebird Mask 

Imagery Year CCAP/NLCD1 Census 
2020 2016 2010 
2019 2010 2010 
2018 2010 2010 
2017 2010 2010 
2016 2010 2010 
2015 2010 2010 
2014 2010 2010 
2013 2010 2010 
2012 2010 2010 
2011 2010 2010 
2010 2010 2010 
2009 2010 2010 
2008 2010 2010 
2007 2006 - Post Katrina 2010 
2006 2006 - Post Katrina 2010 
2005 2006 - Post Katrina3 2010 
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2004 2006 - Pre Katrina 2000 
2003 2001 2000 
2002 2001 2000 
2001 2001 2000 
2000 2001 2000 
1999 2001 2000 
1998 1996 2000 
1997 1996 2000 
1996 1996 2000 
1995 1996 2000 
1994 1996 1990 
1993 1992 1990 
1992 1992 1990 
1991 1992 1990 
1990 1992 1990 
1989 1992 1990 
1988 1992 1990 
1986 1992 1990 
1985 1992 1990 

 

11992 Data is NLCD data, as CCAP was unavailable after 1996 
2Used to mask out upland forests and high and medium intensity urban areas 
3Hurricane Katrina made land fall in late Aug 2005, towards the end of the Early shorebird habitat 
assessment period. 

For future classifications, if new land cover or census data becomes available, then the mask will be 
updated for the next full assessment period. For example, if new 2020 census urban data becomes 
available in November 2021, then the mask would be updated for the 2022 assessment. 

Download and Inventory Imagery 
Using Earth Explorer 

1) Go to USGS Earth Explorer 
a.  https://earthexplorer.usgs.gov/ 
b. Create and account or log in 

2) Fill out the Search Criteria tab 
a. Enter the path and row of the image you are searching for. Choose “show”.  

i. If show is not clicked, every path/row will be searched!  
b. Enter the date range for a period. In the image we are searching for Path 26 Row 41 

during the shorebird early period. 

https://earthexplorer.usgs.gov/
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3) Fill out the Data Sets tab 
a. Select Landsat Imagery. Choose Level 2 On Demand imagery 

i. Landsat 4-5 is used for imagery before 2011 
ii. Landsat 8 is used for imagery after 2013 

b. In 2017 and 2018, Landsat has been reorganizing and changing their imagery product 
names. If this occurs in the future, it is important to use imagery that is surface 
reflectance corrected.  
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4) Choose the Results tab 
a. Browse through the available imagery choosing one with the lease amount of cloud 

coverage 
b. Make sure the images are all the same path/row and were all acquired during the 

appropriate time period 
c. If all images are cloud free, choose the image with the acquisition date closest to the 

middle point of the period 
d. It’s OK if all images are very cloudy. Some periods are not classified due to a lack of 

available imagery. Refer to Tables 1 and 2 to see if the imagery is necessary for 
classification.  

e. Preview images by clicking on the image thumbnail. 
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f. Click the shopping cart button to add an image to your cart 
g. In the below image, the first and third images are too cloudy to classify. Upon further 

examination, the second image has the least amount of cloud cover and will be used for 
classification. 

 

5) Return to the Search Criteria page to continue searching for images. Add all imagery needed for 
classification of the time period (ex. Shorebird early 2018 will have a maximum of 14 images 
added in the cart) to your cart.  
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6) Review your order and submit. Orders take a few hours to a few days to process. You will receive 
an e-mail with a link once the imagery is available for download.  

a. Once images are available for download, you have 10 days to download them before you 
must re-order.  

7) Place imagery in the appropriate folder once it is downloaded (See appendix 1.A) 
Image Inventory 

1) Create a new Image Inventory spreadsheet by copying a previous year. 
2) Copy image thumbnails from the Earth Explorer and add relevant details to the inventory.  
3) Open .mxd files containing image footprints in Arcmap. 

a. R:\SC009NO\12\Working\GCJV\mxds\TM 
b. Re-order the images in the mxd document and copy the map into the inventory 

spreadsheet 
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Pre-Process Imagery 
*A note about processing imagery: Mosaicking and shifting imagery in ArcMap takes some time. 
You can “queue” processes in ArcMap by Enabling Background Processing. This will allow you to 
run a tool then open and set a new tool to run afterwards. For more information see 
http://desktop.arcgis.com/en/arcmap/latest/analyze/executing-tools/foreground-and-background-
processing.htm 

Geoprocessing > geoprocessing Options > Background Processing > Check Enable 

Mosaicking Landsat imagery 
1) Download imagery from online.  
2) File the imagery into an appropriate folder and unzip the file. 

a. Using Windows Explorer Right-click .tar.gz file > 7-Zip > Extract Here 
b. Right-click .gz file > 7-zip > Extract Here 

3) In ArcMap, use the Composite Bands tool to composite the first 7 bands (Landsat 8) or the first 
6 bands (Landsat 5). Save this file as IMGNAME + “_composite.img” in the appropriate image 
folder. 

a. Tip: When adding multiple input rasters, click the first raster, hold shift, and click the last 
raster. All rasters in between should be added. Since these rasters are labelled 
consecutively, this makes adding 6 or 7 rasters easy.  

 

4) If any images are in the incorrect coordinate system, use the Project tool to correct this now. Be 
sure to project the already extracted image if necessary. The output should end with 
“_utm##.img” 

a. Set the snap raster to be an adjacent image. For example, if you are projecting P25R40, 
snap the raster to P26R40.  

i. In the Project Raster tool window, Environments > Processing Extent > Snap 
Raster 
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b. When choosing a coordinate system: Projected > UTM > WGS 1984 > select the 
appropriate zone 

c. The following images will be projected: 
• TMC – P25R40 and P2539 to UTM Zone 14N 
• MRCW – P21R40 to UTM Zone 15N  
• CMA – P22R39 to UTM Zone 16N 

d. The default setting of Nearest Resampling Technique should be applied 
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5) Mosaic together the shifted imagery by using the Mosaic to New Raster tool.  
a. Rearrange the images in ArcMap to find the clearest mosaic order 

i. Sometimes there may be a very cloudy image and a very clear image side by 
side. You’d want to put the clear image on top of the cloudy image.  

b. Input rasters should be in order from top to bottom, where the first listed image is on top 
of the others.  

c. Output Location: appropriate folder in the classification folder 
d. Raster Dataset Name: IA_ + wf or sb + _PdYrYr + “_mosaic.img” 
e. Spatial Reference: Choose appropriate coordinate system 
f. Pixel Type: 16_BIT_SIGNED 
g. Cellsize: 30 
h. Number of Bands: 7 -- Landsat 8; 6 -- Landsat 5 
i. Mosaic Operator: FIRST 

 

 
6) Use the “Times for Composite” model in Erdas 

Imagine to correctly scale the mosaic. The output 
should have a type of Float Single, Continuous. 
End the output name with “_scaled.img”. 
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a. Toolbox > Model Maker > File > Open “….GCJV\models\Landsat5 or Landsat 
8\times_for_composite.gmd” 

i. Double click the A and B bubbles to change them. 
ii. Below, A: Input the image mosaic. Do not check temporary raster. Default 

settings are fine. 
iii. Below, B: Output the image mosaic name + “_scaled.img” to the same imagery 

directory. Change the Output Data Type to Float Single, Continuous data type.  
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7) In ArcMap, shift the scaled mosaic to align with the appropriate mask. Be sure to set the snap 
raster to the mask. The output should end with “_shift.img” 

 
a. It might be necessary to change ArcMap to the correct Projection 

i. Right click the name of the data frame in the Table of Contents window (by 
default, the data frame is called “Layers”) 

ii. Choose coordinate System, pick the correct coordinate system 
b. Use the Measure tool to measure how far the pixels need to be shifted  

i. Measurements don’t need to be exact 
ii. In the below image, the red is the mask. The goal is to get the pixels to align with 

the pixels in the mask. An easy place to measure is along coastlines or water 
bodies. The below image needs to be shifted up and to the right.  

c. Use the Shift tool 
i. Input: scaled mosaic 

ii. Output: scaled mosaic name + “_shift.img” 
iii. Shift x coordinates: positive numbers shift the image right, negative values shift 

the image left 
iv. Shift Y coordinates: Positive values shift the image up, negative values shift the 

image down 
v. Snap Raster: Mask raster 
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8) In Imagine, use the subset tool to subset the image to the appropriate IA. Be sure to set the snap 

raster to be the appropriate mask. The output should end with “_subset.img” 
a. Raster tab > Subset & Chip > Subset 
b. Input: Scaled, shifted mosaic 
c. Output: Input mosaic name + “_subset.img” 
d. Check the Snap Pixel edges to raster image boxes 
e. File to snap to: Mask file 
f. Output Data Type: Float Single 
g. Choose the AOI Button and select the AOI File bubble 
h. AOIs are a specific file type to Erdas Imagine. The AOI files for IA boundaries are 

located in “…GCJV\aoi” 
i. Laguna waterfowl: Use laguna aoi 

ii. Laguna shorebird: Use Laguna_bcr37 aoi 
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9) Waterfowl Classifications -- Run the following models in Imagine:  

a. LSWI 
i. Input: subset mosaic 

ii. Output: subset mosaic name + _lswi.img”, continuous data type 
b. NDVIEVI 

i. Input: subset mosaic 
ii. Output: subset mosaic name + _ndvievi.img”, continuous data type 

c. MNDWI 
i. Input: subset mosaic 

ii. Output: subset mosaic name + _mndwi.img”, continuous data type 
d. Waterfowl_classification (Model shown in image below) 

i. Inputs: MNDWI (A), LSWI (B), NDVIEVI (C), subset image (D), mask (E), 
coastline mask (F) 

ii. Output (G): iA_wf_pdYRYR_classification.img 
1. Ex: LAG_wf_e1819_classification.img for Laguna early 2018/2019 

iii. Output should be unsigned 1 bit thematic data 
iv. Coastline masks can be found at “…GCJV\coastline_mask.img” 
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10) Shorebird Classifications -- Run the following models in Imagine: LSWI, NDVIEVI, NDBI, 
MNDWI, and Shorebird_classification. 

e. LSWI 
i. Input: subset mosaic 

ii. Output: subset mosaic name + _lswi.img”, continuous data type 
f. NDVIEVI 

i. Input: subset mosaic 
ii. Output: subset mosaic name + _ndvievi.img”, continuous data type 

g. NDBI 
i. Input: subset mosaic 

ii. Output: subset mosaic name + _ndbi.img”, continuous data type 
h. MNDWI 

i. Input: subset mosaic 
ii. Output: subset mosaic name + _mndwi.img”, continuous data type 

i. Shorebird_Classification 
i. Inputs: LSWI, NDVIEVI, NDBI, MNDWI, subset/mosaicked image, mask file, 

coastline mask 
ii. Output: iA_sb_pdYRYR_classification.img 

1. Ex: LAG_sb_e2018_classification.img for Laguna early 2018 
iii. Output should be 2 bit thematic data 
iv. Coastline masks can be found at “…GCJV\coastline_mask.img”. Shorebird and 

waterfowl coastline masks are the same. 
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Mosaicking Spot Imagery 
1) Obtain imagery. 

 
2) File the imagery into an appropriate folder and unzip the file. 

 
3) Use the spot_rfl_correction.py file (located in the GCJV\models folder) to reflectance correct 

each image.  The output should end with “_rfl.img”. Note: GST level images cannot be corrected 
and therefore cannot be used. 
 

4) Use ArcMap to resample each image to 20m x 20m using the Nearest Neighbor technique.  
 

5) Use the set raster properties tool to set each band to have a no data value of 0. This allows the 
images to be mosaicked without the black collar around the edges. 
>>>>Steps 4 and 5 can be done using the spot_no_data_resample.py code in the GCJV\models 
folder. This takes a directory as an input and makes changes to any image ending with “_rfl.img” 
in the directory and any subdirectories. It will output an image with the following name: 
“IMGNAME_rfl_20m.img”  

6) If any images are in the incorrect coordinate system, use the Project tool to correct this now. Be 
sure to project the already extracted image if necessary. The output should end with 
“_utm##.img” 
 

7) Shift imagery together. All images should be shifted to match any neighboring/overlapping 
imagery. Be sure to shift the projected imagery. 

a. Choose an image in the IA to act as a reference image and starting point. Do not shift this 
image but shift all bordering images towards it. For any non-neighboring imagery, use an 
already shifted image as reference. 

b.  Be sure to set the snap raster to the reference image. 
c. Moving Up and Right are positive (+) shifts; moving Down and Left are negative (-) 

shifts.   
d. The output should end with “_shift.img” 

 
8) Mosaic together the shifted imagery by using the Mosaic to New Raster tool.  

a. Input rasters should be in order from top to bottom, where the first listed image is on top 
of the others.  

b. Output Location: appropriate folder in the classification folder 
c. Raster Dataset Name: IA_ + wf or sb + _PdYrYr + “_mosaic.img” 
d. Spatial Reference: Choose appropriate coordinate system 
e. Pixel Type: 32_BIT_FLOAT 
f. Cellsize: 20 
g. Number of Bands: 4  
h. Mosaic Operator: FIRST 
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9) In ArcMap, shift the scaled mosaic to align with the appropriate mask. Be sure to set the snap 

raster to the mask. The output should end with “_shift.img” 
a. It might be necessary to change ArcMap to the correct Projection 
b. Use the Measure tool to measure how far the pixels need to be shifted  
c. Use the Shift tool 

 
10) In Imagine, use the subset tool to subset the image to the appropriate IA. Be sure to set the snap 

raster to be the appropriate mask. The output should end with “_subset.img” 
 

11) Use the base SPOT classification model and tweak thresholds until habitat appears correct. Save 
the model with a new number and record the number of the model, as well as the thresholds, in a 
spreadsheet. 
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Editing a Classification in ERDAS Imagine 
These instructions are for ERDAS Imagine 2016. 

Set up and Display 
1) Open Imagine and layout files. 

a. File > Open > Layout 
b. Browse to R:\........GCJV\models\ imagineLayout_forClassifying.ixw 
*Opening the layout file is optional. These directions indicate where to locate tools on both 
the preset layout and the custom layout mentioned above; however, images in these 
instructions are strictly from the custom layout. Feel free to make your own custom layout 
once you are familiar with the tools necessary to create and edit classifications! 

 

 
 

2) Open the subset image and display with the Land/Water band combination 
a. File > Open > Raster Layer > browse to and choose a subset image OR drag and drop 

the .img file from Windows Explorer into the Table of Contents 
b. With the image name selected (it will be highlighted in blue) in the Contents window, 

choose Multispectral under the Raster toolbar.  
c. Assign the Red, Green, Blue display to be the following bands for LandSAT 8 imagery 

i. Red – Layer_5 
ii. Green – Layer_6 

iii. Blue – Layer_4 
d. Assign the Red, Green, Blue display to be the following bands for LandSAT 5 imagery 

i. Red – Layer_4 
ii. Green – Layer_5 

iii. Blue – Layer_3 
e. Right click the image name and choose Fit Layer to Window 
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f. Adjust the image as needed using Adjust Radiometry in the Enhancement section of 
the Raster/Multispectral tab. 

 
 

3) Open the classification file and display appropriately. 
a. Open the classification file which corresponds to the image and place it on top of the 

image. 
b. Right click the classification file name in the Contents window.  
c. Choose Display Attribute Table.  
d. Set the Opacity of the 0 values (Row = 0) to be 0. This means it is completely 

transparent. 
e. Choose a color of your choice for the pixels with a value of 1 (Row = 1). These pixels 

have been classified as habitat.  
f. Click the ‘x’ to exit out of the Attribute Table box and save changes made. 

 

4) (Optional) Set up tracking 
a. My Workflow tab > Add Views (in the Windows section) > Create Overview 

i. A new window will appear. This will be used to view how much of the Initiative 
Area you have reviewed.  
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b. Change the Extent to a size you prefer.  
i. My Workflow > Extent > Scale Box 

 
 

c. In the Overview window, click and drag the view box to a starting point. This should 
probably be an edge of the image.  

i. In the below image, I will start at the current position of the box and go down to 
the bottom of the image, to the left, back up, etc. Feel free to start where you like.  
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d. In the Overview window, choose the Snail Trail option.  
i. This creates a light highlight in the Overview window over the 

part of the image you have reviewed.  
 

e. Use the Roam buttons to pan through the imagery.  
i. My Workflow > Roam section  

ii. If you choose to use the basic Imagine 
layout, this tool is located under Home tab 
> Roam section 

iii. The green arrows will pan without 
stopping. The outside arrows will pan to 
the end of the image. You will want to use 
the middle Step Forward arrow to step 
forward one viewing extent.  

iv. You can pan horizontally or vertically by setting the direction. Do this by 
clicking the ‘squiggly’ arrow button to the left of the speed buttons. 

v. You can change the speed by clicking the up or down clock buttons.  
vi. Note: These buttons are kind of finnicky. You might want to start by using the 

Go to End arrow and pan from there. The first time you pan, make sure no 
polygons are selected. If you get off track, you can always stop the snail trail and 
resume it later.  

vii. There are other ways to pan through the imagery (covered later), but the Roam 
tool saves your place (see Tips) if you need to save your work for later.  
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5) Set up the Swipe 
a. My Workflow > View section > Swipe 
b. If you choose to use the basic Imagine layout, this tool is located under the Home > View 

Section > Swipe 

 

c. This will open a new panel called the Transition Panel. Drag this panel by clicking the 
bar with the name and dragging.  

d. Layers selected in the Transition Panel will be able to be swiped on and off. Check the 
‘W’ box next to the classification layer.  

e. To see the imagery underneath a classified pixel, use the Swipe Bar to do so.  
i. My Workflow/Transition > Transition Extent section > Location slider 

 
 

6) Set up the Recode tool 
a. Select the classification layer in the Contents panel 

i. My Workflow > Edit section > Recode 
ii. If you choose to use the basic Imagine layout, this tool is 

located under the orange Raster tab > Thematic > Edit 
section > Recode 
*The Recode tool is always available in the My Workflow 
tab, should you choose to use the already made custom 
layout from step 1. In the preset layout, the classification 
layer must be selected to find this Recode tool button. Do not use the Recode tool 
button in the grey raster tab/Raster GIS section/ Thematic menu. This is a 
different tool.  

b. A new panel will appear. This tool allows you to change pixel values. The “Old Value” 
column is the current value of the pixel. The “New Value” column is the value you want 
the pixels to be. In the below image, the pixels with a value of 1 will be changed to 0. 
Changes will take place when Apply is chosen. 

i.  Note: If you choose Apply and no Area of Interests are selected, changes will be 
applied to EVERY pixel in the classification. Step 7 details creating Area of 
Interests (AOI). 
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Editing a classification 
***Familiarize yourself with types of errors using Appendix 1.B before editing.  

1) In the Imagine main screen, select the AOI button to create a 
new AOI.  

a. My Workflow > Insert Geometry section > 
Polygon button 

b. If you choose to use the basic Imagine layout, this 
tool is located under the Orange Raster tab > 
Drawing > Insert Geometry section > Polygon 

 
2) Select the lock button so that you can continue to draw polygons without being interrupted. If the 

lock button is not selected, every time you draw a polygon, you will need to click the polygon 
button. If the polygon button is not selected, you will not be able to draw. 
  

3) Pan through the image using the Roam buttons.  
a. If you choose not to use the Roam buttons, there are several ways to pan. 

i. My Workflow or Home tabs > Extent section > Pan tool will allow you to 
click and drag on the screen. 

1. This will turn your cursor to a hand 
ii. Home > View section > Smart Control will set up a compass on the screen. 

You can click the arrows to pan through the image.  
iii. Use the slide bars/arrows on the side of the screen to scroll through the image.  
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4) If you see a glaring error, use the Polygon tool to draw a polygon around the erroneous pixels.  

a. When drawing polygons, your cursor will be a cross 
 

5) The polygon should already be selected. If it is not selected, use the select tool to do so now. A 
selected polygon will have a box around it which allows you to rotate or resize it. 

a. My Workflow/Home > Modify section > Select tool 
b. This should turn your cursor back to a white arrow.  

 
6) Use the Recode tool to recode the selected pixels as specified. Most of the time, you will be 

reclassifying 1 values to 0 values and 0 values will stay 0 values. 
a. ALL SELECTED POLYGONS will be affected by the Recode tool when you hit apply 
b. If no polygons are selected, ALL PIXELS will be affected by the Recode tool so make 

sure a polygon is selected  
 

7) Continue panning through the image and recoding pixels as necessary. 
a. Familiarizing yourself with the Editing Tips section right now may help anticipate any 

software oddities before you continue.  
 

8) Save the classification when you are finished. 
a. Right click the classification layer in the Contents panel and choose Save. 
b. Make sure the overview window is not open when you save the layer! 

 
9) If necessary, break up Chenier Plain into Louisiana Chenier and Texas Chenier Subset (Erdas 

Imagine) 
a. Raster > Geometry > Subset & Chip > Create Subset Image 
b. Input: Chen Classification 
c. Output: Check name standards depending on wf vs. sb 
d. Check snap pixel edges to raster 

i. File snapto: same as input 
e. Output data Type: Unsigned 1-bit Thematic 
f. AOI: to specific area (lachen or txchen) 

 
10) Shorebird Classifications ONLY: 

a. After saving the classification, deselect any AOI polygons that may be selected 
b. Recode classes 1, 2, and 3 to be 1. Keep class 0 as 0.  
c. Right click the classification name in the Contents panel and choose SAVE AS.  

i. DO NOT SAVE. ONLY CHOOSE SAVE AS. YOU WANT AN EDITED 
COPY WITH 1/2/3 VALUES AND AN EDITED COPY WITH ONLY 1 
VALUES.  

d. Save the copy adding a _1 to the file name. 
i. Ex. Chen_sb_early2018_classification_1.img 
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Finalize the classification 
1) Clump together pixels classified as habitat.  

a. Raster tab > Raster GIS section > Thematic > Clump 
b. This function groups together pixels classified as 1 that are touching. 
c. Input: The saved, edited classification file. For shorebird, this will be the 

“…classification_1.img” file.  
d. Output: “….classification_cl.img” (waterfowl) OR “…..classification_1_cl.img” 

(shorebird) 
i. Select Layer: 1 

 
e. Connected Neighbors: 8 (This is important. It makes sure that the tools groups together 

pixels that share all edges, N/E/S/W 
directions, AND pixels that share 
corners, NW/SW/SE/NE directions) 
 
 

2) Sieve clumped file.  
a. Raster tab > Raster GIS section > 

Thematic > Sieve 
b. This function filters all groups of 

pixels, leaving only groups of pixels 
1 acre or greater in size. 1 acres is the 
minimum mapping unit used by the 
GCJV. 

c. Input: The clumped classification file. “….classification_cl.img” 
d. Output: “….classification_cl_sie.img” (waterfowl) OR “…..classification_1_cl_sie.img” 

(shorebird) 
e. Select Layer: 1 
f. Minimum size: 1.00 Acres (THIS IS IMPORTANT) 
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3) Use the “Finalize Classification” model. 

a. Toolbox > Model Maker  
b. In the Model Make window > File > Open > browse to the GCJV models directory and 

open the finalize classification model (“….GCJV\models\finalize_classification.gmd”) 
c. Once the model opens, double click the jagged input/output bubbles to change the inputs 

and outputs. 
i. (A)  The clump_sieve file will always be the file ending in “ _cl_sie.img”  

d. (B)  The Original Classificaiton file will be the file ending in “…_classification.img” 
that you originally edited. Do not use the shorebird file with only 1 values.  

e. (C)  Name the final classification in the following format 
InitiativeArea_wf/sb_pdYrYR_classification_final.img 

f. The data type for the final waterfowl classifications will be Unsigned 1-bit Thematic 
g. The data type for the final shorebird classifications will be Unsigned 2-bit Thematic 
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Proof the classification and make any additional edits 

**When making final edits, make sure you do not edit any segments to be less than the minimum 
mapping unit. All clumps of habitat must be >= 4 pixels (Landsat imagery only) 

h. View the image, final classification file, and corresponding mask file in Erdas Imagine 
and scan through the classification looking for any additional areas that need to be edited.  

i. I like to view the image at a smaller scale, 1:50,000. The different perspective sometimes 
reveals things you wouldn’t have noticed before (maybe a cloud that was off screen is 
revealed and you can now clearly notice a cloud shadow).  

4) In ArcMap, use the Build Raster Attribute Table tool on the final classification 
a. If this is not done, the attribute table will reflect the number of pixels in the classification 

before any edits were made.  
b. Check the Overwrite button. 

 

5) Input the amount of habitat into the correct summary spreadsheet 
a. Landsat imagery - put the following formula into the excel spreadsheet 

i. # pixels (from attribute table) * 900 * 0.000247105 
Editing Tips/Things of Note  

• Undo a mistake if you accidentally recode 
incorrect pixels 

a. Select the classification in the 
Contents window 

b. Choose the Undo Arrow which can 
be found in a variety of places 

i. Upper toolbar next to the save 
icon 
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ii. My Workflow > Edit Section > Undo  
iii. Home > Edit section > Undo 
iv. Orange Raster tab > Drawing > Edit section > Undo 

 
• You can pan, draw, recode without having to delete any polygons you draw (In ERDAS 

Imagine 2016. This may change in future versions), though you can choose to delete 
them.  

a. Delete a polygon by selecting it and choosing the Red Delete X button in an edit section 
of any tab 

b. Make sure the AOI layer in the Contents window is selected 
 

• Saving mid-way through a classification and you are using Overview to track your place: 
a. If you wish to save part way through editing a classification, make sure the Overview 

window is not open. You can close the Overview window, save, and create a new 
Overview later.  
 

• The Roam tool keeps your place if you need to save mid-way through a classification 
a. You will not be in the same place as when you saved, but when you use one of the step 

forward Roam tool buttons, it will take you to the exact place you left off (If you’ve 
already been using the Roam tool…).   

i. The Roam tool will NOT save your place if you exit out of the Imagine software 
completely. This only works if you minimize Imagine or lock your screen.  

b. If you are not using the Roam tool, be sure to note the location where you saved your 
work using the coordinates in the bottom right of the screen. 
 

• Noting Coordinates  
a. You may want to take note of the coordinates of a specific area. You can do this by 

placing your cursor on the screen and jotting down the coordinates in the bottom right of 
the screen. 

b. You can change the coordinate system by clicking on the numbers and choosing a desired 
system. 

c. Fun fact, you can type Lat/Long Decimal degrees coordinates into Google Earth to view 
an area close up if needed. 
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Maximum Extent (waterfowl only) 
Whenever all the classifications for a period for an initiative area are finalized, maximum extent must be 
created for early/middle/late and middle/late: 
1) Raster Calculator (ArcMap) 

a) Input all Classifications for a current period for the specific Initiative area 
b) Go to ArcToolbox > Spatial Analyst Tools > Map Algebra >Raster Calculator 

i) Example input syntax for 2002–03: Con(("lag_wf_e0203_classification_final.img" == 1) | 
("lag_wf_m0203_classification_final.img" == 1) | ("lag_wf_l0203_classification_final.img" 
== 1), 1, 0) 

c) Input the specific classifications for the Initiative area you wish to create max extent for.  
d) For Early Middle Late maximum extent, include all three Early Middle Late classifications, and 

for Middle Late maximum extent only include the Middle and Late classifications in the syntax. 
e) Output location: 

R:\SC009NO\12\Working\GCJV\waterfowl_assessment\classifications\current_method\YYYY\ 
Max_Extent 

f) Output Name: IA_wf_EML(or ML)YYYY_classification_final.img 

Finding Unmasked Initiative Area Acres 
1) Use the appropriate subset image, model, and mask to compute the total possible area classified 

for each unique initiative area/mask combination. 
*Only needs to be done once per mask 

a. In ERDAS: “….\GCJV\ 
models\unmasked_area\find_total_unmasked_area_using_inverse_mask.gmd” 
 

a. Mask input: Input the mask that is subset. This will ensure that imagery used is 
standardized for ERDAS Imagine as there can be discrepancies when working between 
ArcGIS and ERDAS. 
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b. Imagery input: IA vector rasterized in ERDAS (tab: manage data  Vector to Raster) 
IE: 
“R:\SC009NO\12\Working\GCJV\IA_Bounds\IA_Bounds_Update\*IA*\*IA*_utm14_w
gs84_raster.img”  “*\*IA*_utm14_wgs84_raster_erdas.img” 

c. Output to appropriate mask folder for shorebird/waterfowl 
Name the output: 
*IA*_shorebird_mask_2010_urban_2010_ccap_nhdh_extract_thematic_subset_inverse.i
mg 

2) Review the unmasked area raster to ensure all pixels were correctly classified by the model. 
a. Clouds can cause pixels to have odd values. Sometimes the software updates, causing the 

values around subset imagery to be different. Sometimes Landsat will change how they 
process imagery, too. Make sure all unmasked pixels of the image are classified as 0 

3) If there are discrepancies (ie, pixels outside the mosaic imagery, this will most likely be the case), 
correct with the extract by mask tool:   

a. Mask input: subset mosaic from the appropriate IA 
b. Imagery Input: 

*IA*_shorebird_mask_2010_urban_2010_ccap_nhdh_extract_thematic_subset_inverse_
mask_erdas.img 

c. Output to appropriate mask folder: add “extract” to inverse mask 
4) Convert the number of pixels in the image to acres. 

a. Value goes into the Unmasked Initiative Area Acres column of the habitat summary 
spreadsheets. 

b. # pixels * 900 * 0.000247105 = # acres (Landsat) 
c. # pixels * 400 * 0.000247105 = # acres (SPOT) 

Finding Number of Acres Classified 
Perform the following for each classification in which a portion of the IA could not be classified: 

*This will be done for most every classification.  

*If an image mosaic has all images and no part of the boundary is cut off (For example, the Laguna 
Madre classifications are typically completely covered by available imagery), copy the Unmasked 
Initiative Area Acres value into the Acres of Initiative Area Classified column. 

1) Use the Raster Calculator tool in ArcGIS to find number of acres classified:  
a. Mask input: inverse mask generated in previous step (in mask folder, ie: 

“*IA*_shorebird_mask…inverse_mask_erdas.img” OR the inverse_extracted mask 
created in step 3) 

b. Scene input: Julian Date mosaic for IA/Period* in 
“…classifications\current_method\YRYR\IA\Period\other\” (if there is no existing 
julian date layer for historical classification years, mosaic together relevant composite 
images & save as “IA_pyYr_raster_layer.img”)  

c. *Note: julian date raster for TX Chen cuts off part of the IA, use the subset mosaic layer 
as scene input instead 
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d. Output: 
“…classifications\current_method\YRYR\IA\Period\other\IA_sb/wf_pdYrYr_con_c
lassified.img 

e. Con syntax: 
Con(("tmc_shorebird_mask_2010_urban_2010_ccap_nhdh_extract_thematic_subset_inverse_ma
sk_erdas.img" == 1) & ("tmc_sb_e2009_julian_date.img" > 0),1,0) 
 

2) Convert the number of pixels in the image to acres to find the actual area classified by the 
available imagery.  

a. Value goes into the Acres of Initiative Area Classified column of the habitat summary 
spreadsheets. 

b. # pixels * 900 * 0.000247105 = # acres (Landsat) 

c. # pixels * 400 * 0.000247105 = # acres (SPOT) 
Finding Mean Julian Date 

1) Use the Con tool in arc map to create a raster with a constant value reflecting the Julian date of 
each individual image. Note, for middle period for waterfowl, we’d add 365 plus the julian date 
for images from January. 
Inputs: 

a. Conditional Raster: Composite of the image used in the mosaic (will be shifted/projected 
if necessary) 

b. Expression: none 
c. Constant Value: Julian Date of the image  
d. Output: into the “other” folder of each classification with the name ‘PR_julian_date.img’ 
e. Make sure to set the snap raster to the appropriate mask in the environments tab 

 

2) Mosaic to New Raster the Julian date images in the same order as the mosaic used for 
classification 

a. Place the date rasters in the same order the images were mosaicked together 
i. Look in the image inventory spreadsheet if the order is unknown 
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b. Pixel Type: 16 bit unsigned 
c. Mosaic Operator FIRST 
d. Number of Bands 1 
e. Set the appropriate output location and name, spatial reference, and cell size. 

i. Location: the “other”  
ii. Name: IA_PdYrYr_julian_date.img 

iii. Cell size: Landsat imagery = 30, SPOT = 20 
f. Make sure to set the snap raster to the appropriate mask in the environments tab 

 

3) Use the set null tool to set 0 values to null 
a. Conditional Raster: Julian date mosaic for the IA/period 
b. Expression: Value = 0 
c. False raster: Julian date mosaic for the IA/period 
d. Output: JULIAN DATE NAME +” _ sn.img” 
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4) Use the zonal statistics tool to get the mean Julian date 
a. Input:  Shapefile of unmasked areas in the initiative area 
b. Zone field: FID 
c. Input Raster: JULIAN DATE NAME + “_sn.img” 
d. Statistics type: MEAN 
e. Check the “Ignore NoData in calculations” box 
f. Output Raster: JULIAN DATE NAME + “_sn_zonal.img” 

 

5) The output should have one mean Julian Date. Use truncated integer as the mean date. Do not 
round the date up.   

a. Use the Mean Julian Date calendar to find 
the date and record the month, day, and year 
on the summary spreadsheet (Appendix 1.C) 

b. The below example is equivalent to 
September 2, 1997. 
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Calculating Mid Only/Late Only/Shared (waterfowl 
only) 
To determine the amount of maximum extent acres being shared from the middle and late periods, and to 
determine the number of acres coming from each period, a simple calculation must occur within the Fall 
and winter surface water assessment for waterfowl habitat spreadsheet.  

1. Determining the amount of Maximum Extent acres that come from the middle period 
classification (Middle only):  

a. If the Middle period acres are less than the late period acres, Subtract the late period acres 
from the maximum extent acres to get the middle only acres. If late period acres are 
greater than the middle period acres, calculate the late only acres first and then subtract 
the late only acres from the middle period acres.   

i. Use this formula in the spreadsheet to automatically calculate:              
=IF(middle cell<late cell,maximum extent cell-MAX(middle cell:late 
cell),Middle cell-Late only cell) 

 

2. Determining the amount of maximum extent acres that come from late period classification (late 
only): 

a. If the middle period acres are greater than the late period acres, subtract the middle period 
acres from the maximum extent acres. If the middle period acres are less than late period 
acres, subtract the shared acres from the late period acres.  

i. Use this formula in the spreadsheet to automatically calculate:             
=IF(middle cell>late cell,maximum extent cell-MAX(middle cell:late cell),Late 
cell-Shared cell) 
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3. Determining the amount of Maximum extent acres that are shared between Middle and Late 
(Middle-Late Shared): 

a. If the middle period acres are less that the late acres value, subtract the middle only acres 
value from the middle acres value. If middle period acres are greater than late period 
acres, then subtract late only acres from the late period acres value.  

i. Use this formula in the spreadsheet to automatically calculate:             
=IF(middle cell<late cell, MIN(Middle cell:Late cell)-Middle only cell, 
MIN(Middle cell:Late cell)-Late only cell) 
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Add Files to Deliverables Folder *Not currently 
done using this script 
The Deliverables directory is located at R:\SC009NO\12\Working\GCJV\Deliverables. 

Copying imagery to the deliverables directory 
 

While manually creating all new image directories, copying .tar.gz files, and subsequently renaming all of 
the files is possible, it is easiest to copy images from the GCJV\imagery directory to the 
“GCJV\Deliverables\Spatial\Raster\Imagery directory using a python script. 

1)  Open the copy_img_tar_files script 
a. R:\SC009NO\12\Working\GCJV\models\scripts\copy_img_tar_files.py  
b. Right click in Windows explorer and choose Edit With Idle 

i. Do not choose to Edit With Idle in ArcGIS Pro as this script uses a different 
version of Python 

ii. The script will look like the image below 

 

2)  Choose Run > Run Module 
a. Nothing needs to be changed unless the imagery directory or the deliverables directory 

changes 
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b. Output will look like the below image. The script will end with “Finish” 
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Appendix 1.A.: Imagery Directory and Deliverables 
1) All images are located in the GCJV\imagery folder 

a. \CDR: contains Landsat imagery composites and/or tar files 
b. \SPOT_wf_update:  contains SPOT imagery processed for the updated SPOT waterfowl 

classifications. If SPOT images are used for historic shorebird classifications, a new 
directory will need to be created 

c. \shorebird_old: archived imagery for shorebird classifications. Images are not surface 
reflectance corrected 

d. \waterfowl_old: archived imagery for old waterfowl classifications. Images are not 
surface reflectance corrected 

2) Images are organized by Path/Row  Year  Date 
3) Each date contains one of the following: 

a. .tar.gz compressed image file 
b. image composite (all bands together) 

Classifications Directory  
1) Within the GCJV\Waterfowl or GCJV\Shorebird directories, you can find the 

classifications\current_method folders.  
2) Classifications are organized by year then by initiative area 
3) Within each year\IA\Period directory, there are 4 folders. Use the folders for the following files 

(To save space on the network, delete all files that are not the final product once the 
classification is finalized.) 

a. \Classifications 
i. Original classification file 

ii. Clumped classification 
iii. Sieved classification 
iv. Final classification 
v. Final subset classifications (Chenier Plain 

waterfowl classifications) 
vi. Sometimes final classifications have errors and must be fixed. Keep those 

changes in this folder too. Put any erroneous final classifications into an “old” 
directory. (For example, there may be a final classification and a final_masked 
classification, which is the amended and “true” final product.) 

vii. Delete the clumped and sieved classifications once final classification is 
completed 

b. \Imagery 
i. Image mosaic 

ii. Scaled mosaic 
iii. Shifted mosaic 
iv. Subset mosaic 
v. Delete the initial mosaic, scaled mosaic, and shifted mosaic once final 

classification is completed. 
c. \Indices 

i. MNDWI 
ii. NDVIEVI 
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iii. LSWI 
iv. NDBI (Shorebird only) 

d. \Other 
i. Julian date images 

ii. Julian date mosaic 
iii. Julian date set null mosaic 
iv. Julian date zonal mosaic 
v. Area classified raster 

vi. Delete all files besides the final Julian date zonal mosaic and the final area 
classified file.  

File Naming Conventions 
Type Abbreviation  

IA = Initiative 
Area 

lachen = Louisiana Chenier 

txchen = Texas Chenier 

chen = Chenier Plain 

lag = Laguna Madre 

tmc = Texas Mid-Coast 

cma = Coastal Mississippi-Alabama 

mrcw = Mississippi River Coastal Wetland 

Type sbs = shorebird spring 

sbf = shorebird fall 

wf = waterfowl 

pYYYY Period, Year(s) (last two digits of both years for wf and full year for sb) 

Periods (if 
applicable, 
Shorebird 
spring 
assessments 
do not have a 
period) 

e = early 

m = middle 

l = late 

Max Extent 
(waterfowl 
only) 

eml = early middle late 

ml = middle late 
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Indices LSWI = Land Surface Water Index 

MNDWI = Modified Normalized Difference Water Index 

NDBI = Normalized Difference Built-up Index 

NDVI = Normalized Difference Vegetation Index 

NDVIEVI = Normalized Difference Vegetation and Enhanced Vegetation Index 

 

Generic file names with examples 

Type Generic file name with examples 

Mask (with same year for 
data sources) 

IA_type_mask_YYYY_urban _ccap_nhdh_thematic_DDMMYY.img 

eg.,  chen_waterfowl_mask_2010_urban_ccap_nhdh_thematic.img 

Mask (with two years for 
data sources 

IA_type_mask_YYYY_urban_YYYY_ccap_nhdh_thematic_DDMMYY.img 

eg., chen_waterfowl_mask_2010_urban_2010_ccap_nhdh_thematic.img 

Final classification IA_type_pYYYY_classification_final_DDMMYY.img 

eg., for sb:  chen_sbf_e2017_classification_final.img 

eg., for wf:  txchen_wf_e1718_classification_final.img 

Final Max Extent 
Classification 

IA_type_maxextentYYYY_classification_final_DDMMYY.img 

Eg., for wf early middle late: lag_wf_eml1920_classification_final.img 

Mosaic/Imagery IA_type_pYYYY_mosaic_scaled_shift_subset.img 

eg.  for sb:  lachen_sb_e2018_mosaic_scaled_shift_subset.img 

eg., for wf: lachen_wf_e1819_mosaic_scaled_shift_subset.img  

Indices IA_type_pYYYY_mosaic_scaled_shift_subset_index.img 

eg., for sb:  lachen_wf_e2018_mosaic_scaled_shift_subset_lswi.img 

eg., for wf:  lachen_wf_e1819_mosaic_scaled_shift_subset_lswi.img 
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Deliverable Directory 
1) R:\SC009NO\12\Working\GCJV\Deliverables 

a. Put finalized classifications into it’s correct folder within this directory, along with imagery 
inventory spreadsheets for each initiative area. 

b. Also put finalized maximum extents into it’s correct folder within this directory 
c. Robocopy this directory.  

 
Robocopy Files  
After the deliverables directory is ready on the USGS server, it must be transferred to the GCJV server. 
Using the Robocopy command in Windows, you can easily copy only files which are new or have 
changed from one directory to another.  

1) Open the Command Prompt 
a. Start Menu > Run > Search “cmd”  
b. Start Menu > Programs > Accessories > Command Prompt 

2) To copy the Deliverables folder to the external hard drive type the following and hit enter 
a. robocopy SourceDirectory DestinationDirectory /e /v /z /r:2 /w:0 
b. robocopy R:\SC009NO\12\Working\GCJV\Deliverables E:\GCJV\Deliverables /e /v /z 

/r:2 /w:0 
c. Step B will copy all new and changed files from the Deliverables folder in the GCJV 

directory to the Deliverables folder on the external drive. The below image is an example 
of what you will see.  

 

3) Repeat the robocopy to copy the files from the external hard drive to the correct folder on the 
GCJV server. You will need to robocopy the waterfowl classifications, shorebird classifications, 
and imagery separately since they are not consolidated in one directory. 

This process will run for a while, depending on how many files are being copied. 
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Appendix 1.B.: Signature Dictionary 
Airstrips 
Airstrips are usually L shaped features. They are characteristic of man-made features as they have straight 
edges and appear bright (They reflect all bands). These are often erroneously classified as habitat and 
should be recoded to “not-habitat”. 
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Aquaculture 

 

 

 

A: LA Chenier Plain 538081.69, 3340407.30 UTM Zone 15 WGS 84 

B: LA Chenier Plain 544951.49, 3352020.30 UTM Zone 15 WGS 84 

C: LA Chenier Plain 501661.89, 3335615.10 UTM Zone 15 WGS 84 

Aquaculture ponds are many man-made ponds grouped closely together. The ponds are usually 
rectangular, have straight edges, are medium sized and have one or two pixels between them. These will 
always be wet when they are falsely classified as habitat. These should be coded as not-habitat.  

Clouds & Cloud Shadow 

        

None of the cyan colored pixels are habitat. It is all cloud, cloud shadow, or mask misalignment.  Clouds 
can appear puffy white with a dark shadow, as seen above.  

A 
B  
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Clouds can be very faint. An example of faint cloud shadow (marked in blue by the S) and clouds 
(marked in red by the C) is seen above.  Note that all cloud shadow in a specific image will be at the same 
angle from a cloud due to the angle of the sun and the photograph.  

When you can see through the cloud shadow it is ok to add in habitat that was overlooked by the model or 
to leave in habitat if it is there. In the above image, you can clearly see the field is dry and the cloud 
shadow should be classified as “not habitat”.  

 

Sometimes clouds can be large and hazy. In the above image, large areas of clouds and cloud shadow are 
visible; however, once zoomed into the image, it becomes difficult to discern the darker cloud shadow 
and hazy cloud visually. It is important to take note of areas that may have haze over them before editing 
a classification for errors. Haze may cause errors of inclusion, where pixels are erroneously included in 
the habitat class, and errors of exclusion, where pixels are erroneously classified as non-habitat.  
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Laguna Madre Barrier Islands 
 

 

Wet areas located along barrier islands on the Eastern shore of LAG are not considered habitat if they are 
flooded from the Laguna Madre. In the above image, all of the purple habitat is potentially mis-classified 
as habitat by the model; however, this should be recoded as not-habitat.  

 

 

Purple pixels circled in blue are habitat. These are 
independent of the surrounding salt water bodies 
(the Gulf of Mexico to the East and Laguna Madre 
to the West) and should be classified as habitat.  
Light purple pixels along the western edge that are 
not circled in blue are not habitat.  

 



Final 

58 

 

Mask Misalignment Along Permanent Water Bodies 

(Left) TX Chenier Plain – 324441.69, 3327922.10 UTM Zone 15 WGS 84 

(Right) LA Chenier Plain -- 553105.09, 3417739.10 UTM Zone 15 WGS 84 

 

Water bodies are fluid and change from year to year. This causes erroneous habitat classification along 
river edges and ponds. Mask misalignment along rivers is no larger than one or two pixels wide and 
follows the river or pond. When the mask is viewed on top of the imagery, it is clear the mask was meant 
to cover the entire water body, but it is shifted over.  T 

Mask misalignment is especially prominent in images that have been projected. For example, there are a 
lot of rivers in TMC that do not align with the mask. LAG and MRCW also have a lot of mask 
misalignment along water bodies due to having a lot of water bodies. Mask misalignment is seen along 
both man-made and natural bodies of water.  

Note: River flooding is considered habitat. If the habitat along the river is more than a few pixels wide, do 
not recode it.  

(Left) In the lower part of the image you can see the model has classified a river meander as habitat 
(cyan). However, since it is part of a permanent water body, it is not considered habitat.  It is not river 
flooding, but simply the river meandering.  
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Above are some examples of mask misalignment along man made canals. This error is prominent in 
southern CHEN and MRCW.  

Odd Pixels 
Sometimes pixels are not good quality, especially in older imagery. These will often be neon colors. 
Sometimes only one or two bands will have data making the pixel bright or neon colors.  Interpolate 
habitat based on surrounding pixels.  
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Red Soils 
Red soils are unique to the Southern Laguna Madre region. They are bright, almost neon, red fields and 
are often erroneously classified as habitat due to specific soil properties. Wet vegetated areas that appear 
red-ish are often classified as habitat in other IA’s, especially the Chenier Plains. These fields are habitat. 
The only time you should remove bright red fields is in the Laguna Madre IA. 

 
 

Upland Forests 

 

Upland forests appear as red, red-brown, or red with green patches. Unlike red fields, which appear flat, 
these patches will be textured. A close view of the texture you can expect from forest patches is visible in 
the top image. The bottom image is an overview of a large section of upland forest and some erroneous 
habitat (cyan). 
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Upland forest is most common in the Northern Chenier Plains IAs.  It is also found in the Northern areas 
of other IAs such as TMC and CMA. Look out for very small patches of forest in mid to southern Chenier 
Plain regions. 

Urban Areas 
 

               

Urban areas are often erroneously classified as habitat. Buildings and other urban areas appear bright 
white or dark grey. They will have straight boundary lines. Above is an example of a building at an 
airport that was erroneously classified as habitat (left) and recoded to be not-habitat (right).  

Streets, as pictured in the top of the above images, are also often erroneously classified as habitat. These 
are usually light grey in color, are very straight, and often have right angles where they intersect with 
other roads. Habitat in a thin (one pixel wide), straight line is often a road or man-made water body that 
has erroneously been classified as habitat.  
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Adding in habitat 
Very few cases require manually adding habitat. 

A haze over the habitat  

 

 

 

 

 

 

 

 

 

 

Sometimes a haze or cloud will cause habitat to be mis classified as non-habitat. It is important to recode 
these areas as habitat. An example of haze over habitat is seen above. Notice that the dark purple area of 
habitat is muted by the haze and only some was classified as habitat (top left). In the top right image, the 
error has been corrected.
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Laguna Madre 

 

Often hurricane ponds in the Laguna Madre IA will be erroneously classified as non-habitat. In the above 
image, the dark purple areas should be classified as habitat. It is important to recode these pixels to be 
classified as habitat.  

Note: There is a model for classifying waterfowl habitat named “waterfowl_classification_laguna.gmd”. 
This model can be used to classify habitat in Laguna Madre in wet seasons to cut back on the amount of 
habitat you need to “add in”. This model will classify a lot more clouds and cloud shadow than the 
original waterfowl classification. For this reason, it is not recommended you use this model for cloudy 
periods. The Laguna waterfowl classification model will also classify dryer/redder areas as habitat and 
this will need to be corrected. Using this model during dry periods is not recommended because it may 
increase the amount of editing necessary.  
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Appendix 1.C.: Julian Date Calendar 



Final 

65 

 

 


